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One-Minute NMR Installation Guide 

Friday, October 22, 2010 
 
This is a step-by-step procedure for installing the One-Minute NMR system on a new Protasis Discovery 
Navigation Tower.   
 
 

� Note:  Entry-level systems are typically installed on Dell Dimension computers. 
 

1 One-Minute NMR Minimum System Requirements 

1.1 PC 

Windows XP Professional, Ethernet, 1280x1024 Screen Resolution, 512MB RAM, 40GB Hard Drive, 2 
USB or Serial Ports 

1.2 Liquid Handler 

CTC/Leap HTC PAL, Injector, Stack or Plate Holder, Fast Wash Station 

1.3 Pump 

Protasis HTSL 
 

1.4 Varian System 

VNMR 6.1C or above and VNMRJ, Solaris 8 or Above 
 

1.5 Bruker Systems 

ICON-NMR or TopSpin, Windows or Linux 
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2 Materials Needed 

2.1 One-Minute NMR Installation CD 
2.2 Protasis Instrument Server (or stand-alone Windows XP computer) 
2.3 1 (single solvent) or 2 (dual solvent) Protasis HTSL(s) with RS-232 Cable(s) 
2.4 CTC/LEAP HTC Liquid Handler with RS-232 Cable 
2.5 2 or 3 Sewell (or equiv.) USB Serial Converters 
2.6 Varian or Bruker NMR Spectrometer (see Requirements section) 

3 Setting Up the Computer 

3.1 Make sure that Card Reader (Atech Pro 9 or equiv.) USB Cable is unplugged, so that the hard drive 
will be installed as Drive C:  which is the default location for One-Minute NMR.  See diagram for 
your motherboard for Internal USB connections.   

� Before unplugging the USB cable, note the location and orientation of the four pin Internal USB 
Connector.  When reconnecting at the end of the software installation, be careful to orient the 
polarity of these connectors (as they are not keyed).  Review the drawing for the current 
motherboard before reinstalling the Internal USB Cable. 

 

� Add drawings for FS51, FB51 and FS59 to Appendix ___.  Consider adding a bracket to case to 
allow use of keyed, Type A bulkhead connectors. 

 

3.2 Connect Mouse PS/2 plug to the Green Receptacle on the Rear Panel. 
3.3 Connect Keyboard PS/2 plug to the Purple Receptacle on the Rear Panel. 
3.4 Connect Monitor to 15-pin VGA Receptacle on the Rear Panel. 
3.5 Connect Ethernet from the Netgear Router to the RJ-45 Receptacle on the Rear Panel 
3.6 Save baggies and twist ties for re-packaging 

4 Booting Up the Computer 

4.1 Turn on the Protasis Navigation Tower 
4.2 Turn on the Instrument Server (or Computer) 

� Note: When servicing a Protasis Instrument Server always switch OFF power at the rear of the 
Navigation Tower before servicing. 

4.3 Plug in the External CD Drive. 
4.4 Insert the Windows XP Installation CD in the CD drive. 
4.5 When Prompted in the BIOS, select Boot from CD. 

� Note:  Booting from CD may require changing the BIOS to place USB CD as the first item in the Boot 
list. 

5 Start Windows Installation 

5.1 Before starting, locate the customer’s name and company location.  You will need to enter these 
parameters during the installation. 

5.2 You should see the Welcome to Windows screen.  Press Enter to proceed. 
5.3 Select the Region, Language, and Keyboard Type from the setup. <Next> 
5.4 Select the proper time zone for where the customer is located. <Next> 
5.5 Press <F8> to accept the End User License Agreement (EULA). 
5.6 Windows will show you any existing partitions on the hard drive. 
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�  If the drive is unformatted, proceed by hitting <ENTER>. 

�  If reinstalling the operating system, you should delete the existing partition, using the ‘D’ option, 
confirm and then confirm again using the ‘L’ option. 

5.7 Format using NTFS using the complete FORMAT. 
5.8 Type in ‘OneMinuteNMR’ (or similar) as the Computer Name.  
5.9 Set the computer description to "One-Minute NMR Server" Next -> 
5.10 Set the computer description to “Protasis One-Minute NMR Server” (or similar). 
5.11 Set the Administrator (several allowed) as ‘Protasis Service’ 
5.12 Type "protasis" for the administrator password and confirm password. Click <Next>. 
5.13 Click Yes, this computer will connect through a local area network or home network.  Click 

<Next>. 
5.14 Typical Settings � 
5.15  Workgroups � 
5.16 Activate the software (requires an Internet connection). 
5.17 When asked, ‘Ready to Register With Microsoft?’, click <No>, not at this time. Click <Next>. 
5.18 Under ‘Who will use this computer?’, type the name of the customer.  Click <Next>. 
5.19 Click <Finish> on the ‘Thank You’ screen. Wait one minute for system to come up again. 
5.20 Screen says "Welcome" for a long time. Just wait. 
5.21 Close any "bubble help" boxes that appear at the lower left using the [x]. 

6 Modify User Account 

6.1 From the Start menu select <Control Panel>, then <User Accounts>. 
6.2 Click on ‘Create A New Account’ and create a new account called ‘Protasis Service’.  Select 

<Administrator> for the Account Type. 
6.3 Select ‘Change an Account’ and select the Protasis Service account to change. 
6.4 Then select ‘Create A Password’  and type ‘protasis’ for the password in the first blank, type 

‘protasis’ again in the second blank to confirm and enter ‘Your NMR Automation vendor’ for the 
hint.  Click <Create Password>. 

6.5 For the question, ‘Do you want to make your files and folders private?’, click <Yes>. 
6.6 Click ‘Change the Account Type’. Check again to make sure Protasis Service is set up as a 

Computer administrator. 
6.7 Close the User Accounts Window. 

7 Install Additional Windows Components 

7.1 Insert Windows XP Professional Installation CD in the CD drive 
7.2 On the Welcome to Microsoft Windows XP screen select ‘Install Optional Windows Components’. 
7.3 Select the following additional items from the Windows Components list. 

7.3.1 Indexing Service 
7.3.2 Internet Information Services 
7.3.3 Management and Monitoring Tools 
7.3.4 Message Queueing 
7.3.5 Other Network File And Print Services 

7.4 Click <Next> 
7.5 On the Completing the Windows Components Wizard click <Finish>. 
7.6 Click [x] Exit 
7.7 Remove the Windows XP Professional Installation CD and return to plastic bag. 
7.8 Restart Computer 
7.9 Log in as "Protasis Service". Password: Protasis 

8 Run Windows Update 

8.1 From Internet Explorer, go to http://update.microsoft.com/ 
8.2 Follow instructions to enable Automatic Updates (recommended). 
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8.3 Follow instructions to load Service Pack 2 (SP2), if not already loaded.  Microsoft will identify all 
required and desirable updates.  Select all updates (recommended). 

�  Note:  Service Pack 2 will be included with releases later than 12/1/2005. 

8.4 Disable Windows Messenger and other programs that can interfere with real-time communications. 
8.5 Message Queuing Notes 

8.5.1 One-Minute NMR uses Windows Message Queueing to communicate between the web 
page interface and the RunProcess that controls the instrument. Message queuing was 
used to minimize the security risk from public access to the One-Minute NMR web site. 

8.5.2 Message queuing is accessed with Start Menu / Control Panel / Administrative Tools / 
Computer Management / Services And Applications / Message Queuing / Private Queues 

8.5.3 Two message queues are used: 
8.5.4 protasis.webclient 
8.5.5 protasis.runprocess 
8.5.6 Because there is no security risk with these private message queues typically we set the 

security to FullControll for Everyone.  Security could be limited to, Delete, Receive 
Message, Peek Message, Send Message, Get Properties, and Get Permissions. 

9 Configure Microsoft Firewall  (requires Service Pack 2) 

9.1 The Microsoft Firewall was introduced with SP2 and will be included on current releases of 
Windows XP Professional.  Note that this is a different service that firewalls produced by McAfee or 
Norton.  Only one firewall should be run at a time. 

� Note:  Older systems should be upgraded to run Windows XP with Service Pack 2.  Older systems 
may upgrade on-line through Microsoft Update. 

9.2 The firewall will block the message queuing service by default. This requires turning on message 
queuing’.  Do this by going to the <Start> menu, selecting the  ‘Control Panel’ and the selecting the 
‘Windows Firewall’ option. 

9.3 Select the ‘Exceptions’ tab and TURN ON (checked) the ‘Message Queuing’ service. 
9.4 Select the <Add Port> option.  Type in: 

Name:    ‘HTML’ 

Port Number:  ‘80’ 

9.5 Message Queuing and HTML should now be ON (cecked). 
9.6 TURN OFF (unchecked) all other Program and Services options.   

�  Note that ‘File and Print Sharing’ should be OFF. 

10 Antivirus 

10.1 For Dell Users:  If the Dell system comes with Norton Antivirus: 
10.2 After restarting the Norton Internet Security Dialog will start. Click <Register Later> on the 

‘Registration Window’. 
10.3 On the ‘Subscription’ page, click <Next>. 
10.4 On the ‘Post Install Tasks’ page click ‘Run Live Update’. 
10.5 Click <Next> (Automatic) 
10.6 On the Summary Window click <Finish>. 
10.7 Click <Next> on LiveUpdate window. 
10.8 Wait until installation is complete. 
10.9 Click <Finish>, then click <OK> to restart the computer. 
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� Note for Dell Users: Antivirus software is typically installed with new Dell computers.  This can 
be uninstalled later by the customer, if desired.  Company accounts typically have there own 
preferences for computer security and will want to install there own software.  It is best to leave it 
in place until the computer is located at the customer's site. 

� Account IT personnel should inform Protasis about all third party additions to the Instrument 
Server.  These should be reviewed, preferably tested for adverse affects and approved by Protasis 
for compatibility before installation. 

10.10 Log in using the (previously setup): 

User ID:   ‘Protasis Service’ 

Password: ‘protasis’. 

11 Increase Screen Resolution 

11.1 Right Click on the Desktop and Select Properties from the Menu 
11.2 Under the Settings tab, select the highest possible resolution under the Screen Resolution tab. Set to 

1280x1024 or higher. Under Color quality select Highest (32 bit). 
11.3 Click <Apply> to accept the new resolution. 
11.4 Click <Yes> to confirm. 
11.5 Click <Advanced>, then select the highest allowable refresh rate. 
11.6 Click OK to Hardware Accleration and dismiss the Display Properties Dialog 

12 Install Drivers 

12.1 Insert Shuttle Driver in External CD drive 
12.2 Install Shuttle Drivers from Driver Menu 

� Intel 
� IDE 
� VGA 
� USB (may already be installed) 
� LAN 
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12.3 Return to Main Menu and Select <Documentation> 
12.4 Install Acrobat Reader. 
12.5 When complete, select the button to open the User Manual. 
12.6 Make a folder attached to the C:\ drive named ‘Protasis’ (may exist already). 
12.7 Make a subfolder named ‘Instrument Server’ and save the Shuttle User Manual to the Instrument 

Server subfolder for later reference. 

13 Install USB Serial Converter(s) 

13.1 Plug the USB to Serial Converter into a free USB port on the computer. 
13.2 Take note of the port it is connected to. You will want to re-connect to this same port. 
13.3 Follow the installation guide for Windows XP on page 12. 
13.4 Remove the Installation CD and place back in envelope and place envelope back in box. 
13.5 Save box for re-packaging. 

14 .NET Framework V1.1 Installation 

14.1 The .NET Framework 1.1 allows you to run applications built using the .NET Framework 1.1.  You 
can get the .Net Framework V1.1 Redistributable from the Protasis One-Minute NMR Installation 
CD,  

14.2 OR you can get it online at 
http://msdn.microsoft.com/netframework/downloads/framework1_1redist/ 

14.3 Select the ‘Developers’ link to download the file. 
14.4 Execute the file and follow the instructions to load the .NET Framework V1.1. 
14.5 Note:  Check to See If You Have the .NET Framework Installed 

You can check to see if you already have the .NET Framework 1.1 installed by clicking Start on your 

Windows desktop, selecting Control Panel, and then double-clicking the Add or Remove Programs icon. 

When that window appears, scroll through the list of applications. If you see Microsoft .NET 

Framework 1.1 listed, the latest version is already installed and you do not need to install it again.  
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15 One-Minute NMR Installation 

15.1 Insert the One-Minute NMR Installation CD into the CD drive. 
15.2 Right Click on <Start> to bring up the Explorer and <Open> the ‘OneMinute NMR’ folder. 
15.3 DATABASE SERVER SETUP:  Open ‘Setup.exe’ in the One-Minute NMR\Database Server 

Setup folder.  This will install the database server installer in C:\Protasis\MSDERelA 
15.4 If a dialog box pops up saying, “The publisher could not be verified.  Are you sure you want to run 

this software?”, do not be concerned.  Click <Run> to proceed.  A Windows Installer box will 
appear, followed by the MSDEInstall Setup Wizard.  Click <Next> to proceed.  Progress bars will 
indicate the state of the installation.  At the end, you should see, “MSDEInstall has been 
successfully installed.”  Click <Close> to close the installer window. 

15.5 RUN PROCESS SETUP:  Open ‘Setup.exe’ in the One-Minute NMR\Run Process Setup folder.  
Note that this operation requires Net Framework 1.1. (from the previous step).  You should see the 
‘One-Minute NMR RunProcess Setup Wizard’.  Click <Next> to proceed. 

15.6 On the ‘Select Installation Folder’ dialog box choose the ‘Everyone’ radio button. 
15.7 Install in the default location c:\Program Files\Protasis Corporation\One-Minute NMR\ 
15.8 Check <Next> twice to proceed with the installation. 
15.9 At the end of this operation, you should see “One-Minute NMR RunProcess has been successfully 

installed.”  Close the installer window. 
15.10 WEBSITE SETUP:  Open ‘Setup.exe’ in the \One-Minute NMR\Website Setup folder. 
15.11 You should see a ‘Select Installation Address’ dialog box.  Select the default directory 

‘OneMinuteNMR’ and the default port ‘80’ and click <Next> twice to start the installation. 
15.12 At the end of the installation, you should see “OneMinuteNMR has been successfully installed”.  

Close the installer. 
15.13 HTSL SETUP:  Install the HTSL Control Utility. 
15.14 SOLVENT CONDITIONER SETUP:  Install the Sparger Control Utility. 
15.15 Change the permissions on the C:\protasis directory so that all users have Full Control. Right 

click on C:\protasis select the security tab, click Users, then the Full Control check box. (See steps 
21.1 to 21.3 to turn on the Security tab.) 

16 Install Hotfix (not required for newer XP versions) 

16.1 Use Windows Explorer to navigate to c:\protasis\MicrosoftHotfixKB825709 
16.2 Run the HotFix Installer NDP1.1-K825709-X86.exe 
16.3 When asked if you want to install the Hotfix, click <OK> To continue installation. 
16.4 Click 'I Accept' to accept the EULA. 
16.5 Click <OK> when installer is finished. 
16.6 A dialog box may ask you to resart the system? Click <Yes>. 
16.7 Log in as Login ID:  ‘Protasis Service’, Password:  ‘protasis’ 

17 Database Installation from Run Process 

17.1 Open the ‘One-Minute NMR’ folder on the Desktop and open the ‘1 Start First - RunProcess’ 
executable. 

17.2 If this is a first-time install, the status box should read ‘ERROR: Connection to database failed’. 
17.3 Select the ‘Database/Setup Server’ menu item. 
17.4 The install will take some time.  You will see a message that says “Please wait while Windows 

configures …” 
17.5 You may be asked to insert the Windows XP Professional CD so that the installer can re-install 

some files it needs. 
17.6 The Microsoft SQL Server Desktop Engine installer may ask you to restart the system. Click <Yes> 

if it does. 
17.7 Log in as Login ID:  ‘Protasis Service’, Password:  ‘protasis’ 
17.8 Remove the Windows XP Pro installation disk and put it back in its plastic bag. 

18 Create and Populate Database 

18.1 REBOOT the Computer now. 

18.2 Re-Open the ‘One-Minute NMR’ folder and start the ‘1 Start First - Run Process’ executable 
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18.3 The status bar should read:  ‘Connection to database failed’. 
18.4 Select the ‘Database/Initialize’ menu item. This will install the database, tables, and data in the 

newly installed server. 
18.5 The status bar will read ‘SUCCESS’ when this is finished. 
18.6 Close the ‘Run Process’. 

�  Note:  If you do not see the ‘SUCCESS’ message, there may be a previous version of the database 
installed.  This will need to be removed from the Control Panel and the process repeated.  Call Protasis for 
instructions for reinstalling the database. 

19 Set Web Site Permissions 

19.1 From <Start>, run the <Control Panel>. 
19.2 Select ‘Performance and Maintanance’ or equivalent, depending upon your Control Panel style. 
19.3 Find the ‘Administrative Tools’ option. 
19.4 Select ‘Internet Information Services’. 
19.5 Select ‘[local computer name]/Web Sites/Default Web Site/OneMinuteNMR’ from the tree view. 
19.6 Right click ‘All Tasks>Permissions Wizard’. 
19.7 Click <Next> to continue. 
19.8 Select the ‘New Security Settings’ radio button.  Click <Next> 
19.9 Select 'Public Web Site' from list.  Click <Next>. 
19.10 Select ‘Replace all directory and file permissions’, Click <Next > 
19.11 Review the Security Summary and click <Next> again, the finish to close this dialog box. 
19.12 You should be back at the Tree View for Internet Information Services. 
19.13 Select (local computer) separate Icon /Web Sites/Default Web Site/OneMinuteNMR/molecules 

from the Tree View. 
19.14 Right click and select the ‘Properties’. 
19.15 Read permission should already be ON (checked). 
19.16 Turn ON (checked) Check ‘Write’ permission. 
19.17 Click <OK> to close this dialog box. 
19.18 Close the ‘Internet Information Services’ window. 

20 Register ASP.NET 

20.1 You must now register ‘ASP.NET’ with Microsoft Internet Information Server  
20.2 From the <Start> menu, select <Run> and type ‘cmd’ in the blank.  Click <OK> 
20.3 Change the directory by typing: 

‘cd \WINDOWS\Microsoft.NET\Framework\v1.1.4322’. 

� If this directory doesn't exist you can find the correct directory by typing : 

‘dir aspnet_regiis.exe /s’ on the command line. 

20.4 Type: ‘aspnet_regiis /i’       
(note the blank after ‘regiis’,  
if /i does’t work try -i). 

20.5 You should then see  

Start installing ASP.NET (v1.1.4322). 

  Finished installing ASP.NET (v1.1.4322). 
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20.6 Close the Command Window. 

21 ASP.NET Security For File Uploads 

21.1 One-Minute NMR requires Web Sharing and this requires that ‘Simple File Sharing’ should be 
TURNED OFF.  To do this, go to ‘Start Menu / Control Panel / Folder Options’.  

21.2 Click on the ‘View’ tab.  Scroll down the list of checkboxes. 
21.3 TURN OFF (unchecked)  the ‘Use simple file sharing (Recommended)’ option. 
21.4 Click <OK> to close the View Dialog Box. 
21.5 Close the Control Panel window. 
21.6 From the <Start> menu, right-click and open ‘Explore’ and navigate to: 

‘C:\Inetpub\wwwroot\OneMinuteNMR’. 

21.7 Right-click on the ‘One-Minute NMR folder and select ‘Properties’. 
21.8 Click the ‘Web Sharing’ tab and TURN ON (checked) the ‘Share This Folder’ option. 
21.9 An ‘Edit Alias’ dialog box will pop up. 
21.10 Type ‘NMR’ for the alias and TURN ON (checked) ‘Read’ for Access permissions.  Select and 

scripts for Application permissions. 
21.11 Click <OK> to close the Edit Alias dialog box. 
21.12 Click the <Security> tab.  You will see a list of Group or User Names. 
21.13 Click <Add> open a ‘Select Users or Groups’ dialog box. 
21.14 On this box, click <Advanced>.  A new box will pop up. 
21.15 On the right of this box, click <Object Types> 
21.16 TURN ON (checked) ‘Users’ from the list.  Turn all other options OFF and click OK to close this 

selection dialog box. 
21.17 Click <Find Now> to display a list of Users. 
21.18 From the list, select ‘ASPNET’ and click <OK>. 
21.19 (local computer)\ASPNET should now be displayed in the List Box for the ‘Select Users or Groups’ 

dialog box 
21.20 Click <OK> to go back to the Security Tab. 
21.21 The ‘ASPNET Machine Account (local computer)\ASPNET’ user should now be selected 

(highlighted) in the OneMinuteNMR Properties window. 
21.22 Under ‘Allow’, TURN ON (checked): 

OneMinuteNMR Folder Properties for ASPNET User 

� Read & Execute,  
� List Folder Contents, 
� Read 
� Write 

21.23 Click <OK> to close the OneMinuteNMR Properties window. 
21.24 From the <Start> menu, right-click and open ‘Explore’ and navigate to: 

‘C:\Inetpub\wwwroot\OneMinuteNMR\molecules’. 

21.25 Right-click on the ‘molecules’ folder to bring up ‘Properties’. 
21.26 Select the ASPNET User and click the ‘Security’ tab. 
21.27 Under ‘Allow’, TURN ON (checked): 

molecules Folder Properties for ASPNET User 

� Full Control 
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21.28 This will TURN ON the other checkboxes in the list. 
21.29 Click <OK> to close the ‘molecules Properites’ dialog box.. 

22 Verify One-Minute NMR Connections 

22.1 Open ‘Internet Explorer’. 
22.2 Confirm the local web site is running by typing http://localhost/  You should see an introductory 

web page. 
22.3 Type in the Address:  http://localhost/OneMinuteNMR/Settings.aspx?RunEnable=true   
22.4 The One-Minute NMR ‘Brain’ should appear. 
22.5 You need to check the COM port settings for your computer. 
22.6 Setting Up the Master HTSL Pump.  At the top of the page, select the ‘Category’ Pull-Down 

Menu option, ‘Available Pumps’.  Enter the name of your Master HTSL Pump first (usually 
‘HTSL1’) under both the ‘Name Field’ and the ‘Master Field’.  Enter the plumbing port that is 
connected to this pump (usually ‘1’) in the ‘Port Field’.  Enter the communications channel that is 
connected to this pump (e.g., ‘COMx’, where x=1-5 depending upon your configuration). 

22.7 Setting Up First Slave HTSL Pump(s).  Select <New> to add a first Slave HTSL Pump for Dual 
Solvent systems.  Enter the name of your Slave Pump in the ‘Name Field’ (normally ‘HTSL2’ for 
the first Slave HTSL Pump)  Enter the name of the Master HTSL Pump in the Master Field (usually 
‘HTSL1’).  Enter the plumbing port that is connected to each slave pump (normally ‘2’ for the first 
Slave Pump) in the ‘Port Field’.  Enter the communications channel that is connected to each Slave 
Pump (e.g., ‘COMx’, where x=1-5 depending upon your configuration). 

22.8 Repeat the Previous Step if you have a Triple Solvent System and set up the Second HTSL 

Slave Pump. 
22.9 Check the other settings in the ‘Brain’ to verify that they are appropriate for you 

configuration.  Each row contains a description of the purpose and syntax for entering 

parameters.  Care should be used in changing system defaults. 
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23 Start the One-Minute NMR Web Site 

23.1 Type in the Address:  http://localhost/OneMinuteNMR/main.aspx?RunEnable=true   
23.2 The ‘One-Minute NMR’ Home Page should appear. If it does, skip the next installation step. 
23.3 Systems that run under a domain controller may not grant permissions to the ASPNET user. In this 

case you will get a message from Internet Information Services that says:  
“Server Application Unavailable 

The web application you are attempting to access on this web server is currently unavailable. … 

your request.”  

In this situation you will have to use an alternative ASP.NET user. The problem and resolution are 
at: http://support.microsoft.com/kb/315158 
23.3.1 Create a new ASP.NET user named ASPUSER. Add this user to the Users group. Give 

the user the password aspnetuserpassword. 
23.3.2 Open the file 

C:\WINDOWS\Microsoft.NET\Framework\v1.1.4322\CONFIG\Machine.config. 
23.3.3 Search for the <processModel section section of Machine.config.  It will look like this: 

<processModel enable="true" timeout="Infinite" idleTimeout="Infinite" 
shutdownTimeout="0:00:05" requestLimit="Infinite" requestQueueLimit="5000" 
restartQueueLimit="10" memoryLimit="60" webGarden="false" cpuMask="0xffffffff" 
userName="machine" password="AutoGenerate" logLevel="Errors" 
clientConnectedCheck="0:00:05" comAuthenticationLevel="Connect" 
comImpersonationLevel="Impersonate" responseDeadlockInterval="00:03:00" 
maxWorkerThreads="20" maxIoThreads="20"/> 

23.3.4 Change userName=”machine” to “userName=”COMPUTERNAME\ASPUSER” and 
password=”aspnetuserpassword”.  

23.3.5 Re-open the One-Minute NMR web page.  
23.4 Select the address from the URL box with the mouse, right click, and select ‘Copy’. 

24 ASP.NET Security For File Uploads 

24.1 One-Minute NMR requires Web Sharing and this requires that ‘Simple File Sharing’ should be 
TURNED OFF.  To do this, go to ‘Start Menu / Control Panel / Folder Options’.  

24.2 Click on the ‘View’ tab.  Scroll down the list of checkboxes. 
24.3 TURN OFF (unchecked)  the ‘Use simple file sharing (Recommended)’ option. 
24.4 Click <OK> to close the View Dialog Box. 
24.5 Close the Control Panel window. 
24.6 From the <Start> menu, right-click and open ‘Explore’ and navigate to: 

‘C:\Inetpub\wwwroot\OneMinuteNMR’. 

24.7 Right-click on the ‘One-Minute NMR folder and select ‘Properties’. 
24.8 Click the ‘Web Sharing’ tab and TURN ON (checked) the ‘Share This Folder’ option. 
24.9 An ‘Edit Alias’ dialog box will pop up. 
24.10 Type ‘NMR’ for the alias and TURN ON (checked) ‘Read’ for Access permissions.  Select and 

scripts for Application permissions. 
24.11 Click <OK> to close the Edit Alias dialog box. 
24.12 Click the <Security> tab.  You will see a list of Group or User Names. 
24.13 Click <Add> open a ‘Select Users or Groups’ dialog box. 
24.14 On this box, click <Advanced>.  A new box will pop up. 
24.15 On the right of this box, click <Object Types> 
24.16 TURN ON (checked) ‘Users’ from the list.  Turn all other options OFF and click OK to close this 

selection dialog box. 
24.17 Click <Find Now> to display a list of Users. 
24.18 From the list, select ‘ASPNET’ (or ‘ASPUSER’ if the user has changed) and click <OK>. 
24.19 (local computer)\ASPNET should now be displayed in the List Box for the ‘Select Users or Groups’ 

dialog box 
24.20 Click <OK> to go back to the Security Tab. 
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24.21 The ‘ASPNET Machine Account (local computer)\ASPNET’ user should now be selected 
(highlighted) in the OneMinuteNMR Properties window. 

24.22 Under ‘Allow’, TURN ON (checked): 

OneMinuteNMR Folder Properties for ASPNET User 

� Read & Execute,  
� List Folder Contents, 
� Read 
� Write 

24.23 Click <OK> to close the OneMinuteNMR Properties window. 
24.24 From the <Start> menu, right-click and open ‘Explore’ and navigate to: 

‘C:\Inetpub\wwwroot\OneMinuteNMR\molecules’. 

24.25 Right-click on the ‘molecules’ folder to bring up ‘Properties’. 
24.26 Select the ASPNET User and click the ‘Security’ tab. 
24.27 Under ‘Allow’, TURN ON (checked): 

molecules Folder Properties for ASPNET User 

� Full Control 
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25 Make One-Minute NMR the Home Page. 

25.1 Select the ‘Tools>Internet Options... menu item 
25.2 Select the General tab. 
25.3 Under ‘Home Page Address’, click <Use Current>. 
25.4 Click <OK>. 
25.5 Close Internet Explorer 

26 Make A Shortcut in the One-Minute NMR Folder 

26.1 Open the ‘One-Minute NMR’ Desktop Folder. 
26.2 Right-Click in the folder. 
26.3 Select ‘New>Shortcut’. 
26.4 Paste or type in: 

‘http://localhost/OneMinuteNMR/main.aspx?RunEnable=true’ 

26.5 Click <Next>. 
26.6 Type ‘One-Minute NMR Web Site’ for the name of the shortcut.  
26.7 Click <Finish>. 
26.8 Double-Click the shortcut to test.  The web site should come up to the One-Minute NMR Home 

Page. 

27 Change Screen Saver Settings 

27.1 Right-Click on the Desktop 
27.2 Select ‘Properties’. 
27.3 Click the ‘Screen Saver’ tab 
27.4 Choose ‘Blank’ from the list of screen saver choices. 
27.5 TURN OFF (uncheck) the option ‘On resume, display Welcome screen’. 
27.6 Click the <Power> button. 
27.7 Select the option ‘Always On’ from the list of ‘Power Schemes’. 
27.8 Click <OK> and <OK> again to exit the dialog box. 

 

 

28 Configure the NetGear Router 

28.1 Ensure that a static IP connection is connected to the WAN RJ-45 Receptacle on the router. 
28.2 Check that one of the LAN ports is connected to the RJ-45 Rececptacle on the Instrument Server (or 

computer). 
28.3 Enable Internal LAN starting from address 192.168.0.2 through address 192.168.0.100 
28.4 Enable DHCP 
28.5 Important:  Add Service for Internal HTTP access on Port 80. 

 

� Stage ONE of the One-Minute NMR Software Installation Procedure is now complete.  If the 

HTSL(s) and LEAP are connected, you may proceed to Stage TWO.  Otherwise, stop until 

the fluidics hardware is connected. 
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29 Automated Setup 

Automated setup is used to configure the serial communications ports for HTSL pumps, the CTC liquid 
handler, and the solvent conditioners. The initial solvent volumes are calculated based on the length of 100 
micron tubing to the NMR probe, the type of solvent, and if sample return is used. 
 
If you have an existing One-Minute NMR configuration you should do perform a Database Backup before 
running Automated Setup. 
 
The Brain data that are configured by Automated Setup are defined in the Settings Category: General, 
Pumps, Available Solvents, and Solvent Change, and in Communications and NMR sections of the General 
category. 
 
The Automated Setup window should be used for initial system configuration, or if changes have been 
made to the serial connections or additional devices have been added. To access Automated Setup open the 
One-Minute NMR RunProcess and select the Run/Automated Setup menu item. Automated setup is 
disabled when the system is running. 
 
 
A warning message will appear. 

 
 
Choose Yes to continue with Automated Setup. Some time, up to a few minutes, will pass as the serial ports 
on the instrument controller computer are scanned. You may hear the CTC liquid handler beep a few times. 
This is normal. 
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The length of tubing from the CTC injector to the NMR probe should be measured and entered in the first 
field. Choose between 5 and 10 microliter flow cells. The serial port for the solvent conditioner and CTC 
liquid handler are detected automatically. 
 
Pump configuration can be changed, but the initial configuration will work in most cases. If you are using 
different solvents than the ones indicated enter the names of the solvents here. 
 
The type of NMR system you will be connecting to and the IP address or host name of the NMR system is 
entered at the bottom of the window. The NMR system is not configured automatically by Automated 
Setup. 
 
To accept the changes you have made in Automated Setup, click the Configure button. The RunProcess 
will be automatically closed. HTSL flow rates and volumes settings will be changed automatically when 
the system re-starts. 
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30 Connect the HTSL(s), Citation and the LEAP 

30.1 Plug in and turn on the HTSL and LEAP. 
30.2 Connect the RS-232 Null Modem cable from the LEAP to the COM port on the computer. This 

cable only works one way. If communication fails reverse the cable. 
30.3 Connect the RS-232 cable from the HTSL to the USB Serial Converter plugged into the computer's 

USB port. 
30.4 Open the One-Minute NMR Web site. 
30.5 Select the ‘Protasis Service’ account. 
30.6 Select the User ‘Protasis Service’. 
30.7 Type in the Password:  ‘protasis’ and click <Log In>. 
30.8 Click on the <Brain>. 
30.9 Make sure the ‘General Settings’ are selected. 
30.10 Edit Communication.CTC.COM 
30.11 Type ‘COM1’ for the value and click Update 
30.12 Edit ‘Communication.HTSL.COM’ 
30.13 Type ‘COM3’ for the value and click Update 
30.14 Click Back on the Internet Explorer navigation bar. 
30.15 Minimize Internet Explorer 
30.16 If they haven't stopped already, WAIT until lights stop flashing on the HTSL. 
30.17 Open the ‘Run Process’ from the One-Minute NMR desktop folder. 
30.18 The LEAP should snap to attention. If it does not, there is a communication problem. 
30.19 Select the ‘HTSL / Test Connection’ menu item. 
30.20 The screen should say ‘HTSL Status: idle, waiting for commands’. 
30.21 Configuring Citation For One-Minute NMR / 

WorkCenter Use 
30.21.1 The Citation controller can be completely defined by a stored ctmem file, it is 

recommended that a OMNMR1pump.ctmem and OMNMR2pump.ctmem be used to 
automatically configure each type of system.  As long as the I2C addresses are the same 
for the valves on all systems, and the A/D connections are the same for all systems, 
configuring a Citation pump for OMNMR use is as simple as loading the ctmem file and 
adjusting the pressure zero for the experimentally determined value. 

31 Populate Tray Table in Database 

31.1 From the One-Minute NMR Run Process select ‘Liquid Handler / Get Tray Information’. The Run 
Process status bar should respond with "Tray setup complete". 

31.2 Go to the One-Minute NMR Web site and click Refresh on the Internet Explorer tool bar. 
31.3 Note: The system comes configured with images of drawers and plate holders for the web page. The 

names of the plates and trays are commonly Tray01 - Tray04 for the tray holders and Stk-01 - Stk-
06 for the drawers. There are images in c:\InetPub\wwwroot\OneMinuteNMR\images that 
correspond to these holders. You may need to change the graphics depending on the specific user 
configuration. 

32 Configure NMR Interface 

32.1 Open the OneMinute NMR Web Site 
32.2 Log In 
32.3 Click on the <Brain>. 
32.4 Edit the value of the NMR.Interface field. Either Bruker.Windows or Varian 

33 Adding the Current Directory to the Path on Linux and UNIX Systems  

One-Minute NMR uses listener.tcl to control and monitor the NMR on Bruker for Linux and VNMR / 
VNMRJ systems. Commands sent to a VNMRJ computer from One-Minute NMR may not be 
recognized because the current directory is not in the path. During software installation the current 
directory should be added to the path in the shell startup script. 
 
The two most common shell programs are the Bourne Shell (bash) and the C Shell (csh). The startup 
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script should be modified for both shells because users can switch between them and scripts can 
specify which shell to use. 

33.1 Bourne Shell 

33.2 Open a new terminal window. 
33.3 ls –a  (read directory contents, you may see .bashrc, this is the startup resource.) 
33.4 gedit .bashrc (edit the startup resource file). 
33.5 If gedit asks you to create the file, say yes. 
33.6 Find the line that starts with export PATH=. If the line does not exist, add a new line. 
33.7 Make sure that ./ is in the path. Add at the end with a colon-dot-slash :./ 
33.8 For example: 

export PATH=$PATH:./ 
33.9 Select File / Save then File / Quit from the gedit menu. 

33.10 C Shell 
33.11 Open a new terminal window. 
33.12  ls –a (read directory contents, you may see .cshrc, this is the startup resource). 
33.13 gedit .cshrc (edit the startup resource file). 
33.14 If gedit asks you to create the file, say yes. 
33.15 Find the line that starts with set path =, if it does not exist add it. 
33.16 Make sure that ./ is in the path. 

For example: set path = ($path ./) 
33.17 Select File / Save then File / Quit from the gedit menu. 

34 Configure Solvents 

34.1 Open OneMinuteNMR Web site 
34.2 Log In 
34.3 Go to <Brain> 
34.4 Select Available Solvents from list of Settings To Edit 
34.5 Click New... 
34.6 Click Edit for the new solvent. 
34.7 Type the name of the solvent exactly (case sensitive) as it is used on the NMR system. 
34.8 Click ‘Update’. 
34.9 Repeat for multiple solvents 

35 Configure Experiments 

35.1 Open OneMinuteNMR Web site 
35.2 Log In 
35.3 Go to the <Brain>. 
35.4 Select ‘Available Experiments’ from list of ‘Settings To Edit’. 
35.5 Click <New...> 
35.6 Click <Edit> for the new experiment. 
35.7 Type the name of the experiment exactly (case sensitive) as it is used on the NMR system. 
35.8 VARIAN: The word 'default' as the first name in an experiment tells One-Minute NMR to use a 

default setup. 
35.9 For the Lock Nucleus type the name of the nucleus as it appears on the NMR system (case 

sensitive). 
35.10 VARIAN: The Exp. # is the number of the background experiment that will be used by default to 

run the system. 
35.11 BRUKER: Exp.# is the default number of the experiment to use. Exp. # Fill can be Use or '=Vial+' 

which indicates the experiment number is to be the vial number plus some value. The Proc.# and 
Proc # Fill are for Bruker Processing. 

35.12 The Number of scans is the default number of scans for this experiment. 
35.13 The Sweep Width is the width of the spectrum in ppm. 
35.14 Click update. 
35.15 Repeat for multiple experiments 
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35.16 Exit the One-Minute NMR Web site and re-start Internet Explorer. A bug prevents the settings from 
updating the main window. 

 

36 Install Scripts On NMR System 

36.1 Varian (Using Script) 
36.1.1 Locate UNIX/Varian directory in distribution and copy OMNMR_installer.tar to the 

/vnmr directory.  
36.1.2 Extract the tar file using tar –xf OMNMR_installer.tar  
36.1.3 Set the current directory to OMNMR_installer (cd OMNMR_installer)  
36.1.4 Run OMNMR_install 
36.1.5 Make sure that the NMR directory where data are stored can be accessed from the 

OMNMR makepath script. If the user does not have an NMR data path, create one named 
/nmrdata on the VNMRJ system. Test makepath by typing makepath /nmrdata/test1. 
There should be no errors. Errors typically result from permission issues. Use chmod 
with an administrator account to change the permissions on the /nmrdata directory. 

36.1.6 The NMR Data Directory needs to be entered for each user. Click people on main web 
page. Enter the NMR Data Path, for example (/nmrdata/username). 

36.2 Varian Manual Installation 
36.2.1 Locate the vnmr directory. It is typically /export/home/vnmr. Call this xxx. 
36.2.2 Create a xxx/vnmr/mrm directory 
36.2.3 Change the permissions on the mrm directory. (chmod 777 mrm) 
36.2.4 Copy listener.tcl from the UNIX/Varian directory to the xxx/vnmr/mrm directory. 
36.2.5 Change the permissions on listener.tcl to read/write/execute. (chmod 777 listener.tcl) 
36.2.6 Copy makepath from the UNIX/Varian directory to the xxx/vnmr/mrm directory. 
36.2.7 Change the permissions on makepath (chmod 777 makepath) 
36.2.8 Test makepath by typing makepath pathname. If necessary modify the first line so that 

csh can be found. 
36.2.9 Edit the top line of listener.tcl so that the TCL interpreter starts when listener.tcl is typed 

on the command line. 
36.2.10 Copy autorun, autorunwerr, autoproc, nmrstatus, and autolock to xxx/vnmr/maclib. 
36.2.11 Change the permissions on autoproc, autorun, autorunwerr, nmrstatus, and autolock to 

777. 
36.2.12  If necessary edit the path in autorunwerr so that the file it writes is in the 

xxx/vnmr/protasis directory. By default it is /export/home/vnmr/mrm. 
36.2.13 Make sure that the NMR directory where data are stored can be accessed from the 

OMNMR makepath script. If the user does not have an NMR data path, create one named 
/nmrdata on the VNMRJ system. Test makepath by typing makepath /nmrdata/test1. 
There should be no errors. Errors typically result from permission issues. Use chmod 
with an administrator account to change the permissions on the /nmrdata directory. 

36.2.14 The NMR Data Directory needs to be entered for each user. Click people on main web 
page. Enter the NMR Data Path, for example (/nmrdata/username). 

36.3 Bruker.Windows 
36.3.1 Copy wait4cmd, autorun, and autoproc from c:\protasis\BrukerWindows to 

c:\Bruker\XWIN-NMR\prog\au, or to the appropriate AU directory for Topspin 
/bruker/topspin/prog/au. 

36.3.2 The Protasis macros can be compiled by opening them with “edau <macroname>” then 
by clicking “Save Compile and Exit” at the bottom of the editor window. 

36.3.3 Set up a Windows drive share so that the One-Minute NMR has access to the command 
file and response file to control the Bruker spectrometer. Use Windows Explorer to locate 
C:\Bruker\XWIN-NMR\prog on XWIN systems and a similar name on Topspin systems. 
Right-click on the Bruker prog directory and select Sharing and Security…from the 
menu. Select the Share Tab then the Share This Folder button. For the Share Name type 
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BrukerProg. Click the Permissions and alow Everyone to have Read and Change 
permissions. 

36.3.4 Create two text files in the Bruker prog directory. Right click on the folder in Windows 
Explorer and select New/Text Document. Rename the two files by clicking on the file 
name once as xwin_cmd.txt and cmd_response.txt 

36.3.5 Map drive P: on the One-Minute NMR computer to BrukerProg on the Bruker 
spectrometer computer. From Windows Explorer right click on My Computer in the tree 
and select Map Network Drive…  Navigate to the share that was just created. Check that 
you can open and modify xwin_cmd.txt and cmd_response.txt from Notepad on the One-
Minute NMR computer using the new share. If there are errors accessing the files it is 
due to security and must be resolved. 

36.3.6 In the One-Minute NMR Brain change the NMR.CommandFile to P:\xwin_cmd.txt and 
NMR.ResponseFile to P:\cmd_response.txt 

36.3.7 In Topspin or XWIN type wait4cmd to start the command listener. 
36.3.8 Change NMR.Interface to Bruker.Windows and start the Run Process to make sure you 

have connectivity to the NMR.  
36.3.9 The Bruker NMR data is stored in a specific location according to how the Bruker 

software is configured. One-Minute NMR must have access to this location using 
network drive mapping so that checks for file overwrites can work.  The location of the 
NMR data folder is specified in one of the following locations: The NMR Data Path for 
each user. If the NMR Data Path for a user is blank, then the Brain setting NMR.Disk is 
used. For Bruker Windows installations with two separate computers for One-Minute 
NMR and Topspin or XWIN-NMR a drive needs to be mapped to the root of the NMR 
data directory. First set up a share by navigating to the NMR data directory (e.g. 
C:\Bruker\Topspin) with Windows Explorer on the Bruker computer. Right click and pull 
up Sharing and Security… from the menu. Select the Share Tab then Share This Folder. 
For the Share Name enter OMNMRData.  

36.3.10 Both on the Bruker NMR computer and on the One-Minute NMR computer map a 
network drive to the OMNMRData share. From Windows Explorer right click on My 

Computer in the tree and select Map Network Drive…  Navigate to the share that was just 
created and pick drive O: as the drive to map. The Brain parameter NMR.Disk can now 
be O: and NMR DataDirectory for users can be O:. 

36.3.11 Map P: on the Bruker computer. 
36.3.12 Create the omnmr_solvent.txt 
36.3.13 Setting up experiments for Bruker Systems 

rpar <experiment> 
getprosol make sure it works 
Change experiment parameters Make sure there are no, or minimal processing macros 
associated with the parameter set. 
wpar <experiment> 

36.3.14 Make sure the drives are defined with O:/ and P:/ 
36.3.15 Include a test.bat and a test.txt  
36.3.16 Map O: to c:\bruker\topspin not c:\bruker\data 
36.3.17 Brain setting should NMR.Disk should be O: 
36.3.18 NMR Data path should be O: 

 
 

 


